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Safety Information

Safety Information

Important Information
Read these instructions carefully, and look at the equipment to become familiar
with the device before trying to install, operate, service, or maintain it. The
following special messages may appear throughout this documentation or on the
equipment to warn of potential hazards or to call attention to information that
clarifies or simplifies a procedure.

Please Note
Electrical equipment should be installed, operated, serviced, and maintained only
by qualified personnel. No responsibility is assumed by Schneider Electric for any
consequences arising out of the use of this material.

A qualified person is one who has skills and knowledge related to the construction
and operation of electrical equipment and its installation, and has received safety
training to recognize and avoid the hazards involved.

The addition of this symbol to a “Danger” or “Warning” safety label indicates that an 
electrical hazard exists which will result in personal injury if the instructions are not 
followed.

This is the safety alert symbol. It is used to alert you to potential personal injury 
hazards. Obey all safety messages that follow this symbol to avoid possible injury or 
death.

DANGER indicates a hazardous situation which, if not avoided, will result in death or serious 
injury.

! DANGER

WARNING indicates a hazardous situation which, if not avoided, could result in death or 
serious injury.

WARNING!

CAUTION indicates a hazardous situation which, if not avoided, could result in minor or 
moderate injury.

CAUTION!

NOTICE is used to address practices not related to physical injury.

NOTICE
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About the Book

About the Book

Document Scope
This document provides information to help you maintain the compatibility of your
EcoStruxure Machine Expert application, project, device firmware, Vijeo-Designer
application, EcoStruxure Operator Terminal Expert application, device description,
and other aspects of your installation, when migrating to more advanced versions
of EcoStruxure Machine Expert and its supporting libraries and software.

EcoStruxure Machine Expert is the successor of the Schneider Electric
programming software SoMachine and SoMachine Motion. The compatibility to
SoMachine and SoMachine Motion versions is also covered by this document.

Validity Note
This document has been updated for the release of EcoStruxureTM Machine
Expert V2.0.

The characteristics that are described in the present document, as well as those
described in the documents included in the Related Documents section below,
can be found online. To access the information online, go to the Schneider Electric
home page www.se.com/ww/en/download/.

The characteristics that are described in the present document should be the
same as those characteristics that appear online. In line with our policy of constant
improvement, we may revise content over time to improve clarity and accuracy. If
you see a difference between the document and online information, use the online
information as your reference.

Related Documents
Document title Reference

EcoStruxure Machine Expert Functions and
Libraries User Guide

EIO0000002829 (ENG);

EIO0000002830 (FRE);

EIO0000002831 (GER);

EIO0000002833 (SPA);

EIO0000002832 (ITA);

EIO0000002834 (CHS)

EcoStruxure Machine Expert Programming
Guide

EIO0000002854 (ENG);

EIO0000002855 (FRE);

EIO0000002856 (GER);

EIO0000002858 (SPA);

EIO0000002857 (ITA);

EIO0000002859 (CHS)

EcoStruxure Machine Expert Device Type
Manager (DTM) User Guide

EIO0000003047 (ENG);

EIO0000003048 (FRE);

EIO0000003049 (GER);

EIO0000003051 (SPA);

EIO0000003050 (ITA);

EIO0000003052 (CHS)
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About the Book

Product Related Information

WARNING
LOSS OF CONTROL
• The designer of any control scheme must consider the potential failure

modes of control paths and, for certain critical control functions, provide a
means to achieve a safe state during and after a path failure. Examples of
critical control functions are emergency stop and overtravel stop, power
outage and restart.

• Separate or redundant control paths must be provided for critical control
functions.

• System control paths may include communication links. Consideration must
be given to the implications of unanticipated transmission delays or failures
of the link.

• Observe all accident prevention regulations and local safety guidelines.1

• Each implementation of this equipment must be individually and thoroughly
tested for proper operation before being placed into service.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

1 For additional information, refer to NEMA ICS 1.1 (latest edition), "Safety
Guidelines for the Application, Installation, and Maintenance of Solid State
Control" and to NEMA ICS 7.1 (latest edition), "Safety Standards for Construction
and Guide for Selection, Installation and Operation of Adjustable-Speed Drive
Systems" or their equivalent governing your particular location.

WARNING
UNINTENDED EQUIPMENT OPERATION
• Only use software approved by Schneider Electric for use with this

equipment.
• Update your application program every time you change the physical

hardware configuration.
Failure to follow these instructions can result in death, serious injury, or
equipment damage.

Terminology Derived from Standards
The technical terms, terminology, symbols and the corresponding descriptions in
this manual, or that appear in or on the products themselves, are generally
derived from the terms or definitions of international standards.

In the area of functional safety systems, drives and general automation, this may
include, but is not limited to, terms such as safety, safety function, safe state, fault,
fault reset, malfunction, failure, error, error message, dangerous, etc.
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Among others, these standards include:

Standard Description

IEC 61131-2:2007 Programmable controllers, part 2: Equipment requirements and tests.

ISO 13849-1:2015 Safety of machinery: Safety related parts of control systems.

General principles for design.

EN 61496-1:2013 Safety of machinery: Electro-sensitive protective equipment.

Part 1: General requirements and tests.

ISO 12100:2010 Safety of machinery - General principles for design - Risk assessment
and risk reduction

EN 60204-1:2006 Safety of machinery - Electrical equipment of machines - Part 1: General
requirements

ISO 14119:2013 Safety of machinery - Interlocking devices associated with guards -
Principles for design and selection

ISO 13850:2015 Safety of machinery - Emergency stop - Principles for design

IEC 62061:2015 Safety of machinery - Functional safety of safety-related electrical,
electronic, and electronic programmable control systems

IEC 61508-1:2010 Functional safety of electrical/electronic/programmable electronic safety-
related systems: General requirements.

IEC 61508-2:2010 Functional safety of electrical/electronic/programmable electronic safety-
related systems: Requirements for electrical/electronic/programmable
electronic safety-related systems.

IEC 61508-3:2010 Functional safety of electrical/electronic/programmable electronic safety-
related systems: Software requirements.

IEC 61784-3:2016 Industrial communication networks - Profiles - Part 3: Functional safety
fieldbuses - General rules and profile definitions.

2006/42/EC Machinery Directive

2014/30/EU Electromagnetic Compatibility Directive

2014/35/EU Low Voltage Directive

In addition, terms used in the present document may tangentially be used as they
are derived from other standards such as:

Standard Description

IEC 60034 series Rotating electrical machines

IEC 61800 series Adjustable speed electrical power drive systems

IEC 61158 series Digital data communications for measurement and control – Fieldbus for
use in industrial control systems

Finally, the term zone of operation may be used in conjunction with the description
of specific hazards, and is defined as it is for a hazard zone or danger zone in the
Machinery Directive (2006/42/EC) and ISO 12100:2010.

NOTE: The aforementioned standards may or may not apply to the specific
products cited in the present documentation. For more information concerning
the individual standards applicable to the products described herein, see the
characteristics tables for those product references.
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General Information

Overview
This chapter gives you general information about the different aspects of
compatibility and migration situation you can encounter.

General Information

Overview

EcoStruxure Machine Expert and the devices supported by EcoStruxure Machine
Expert are continuously improved. Therefore, new updates of EcoStruxure
Machine Expert and its associated supports are released on a regular basis.

EcoStruxure Machine Expert provides, in most cases, a simple, and straight
forward way to migrate projects created with previous versions to the present
version.

NOTE:
• Launch the Schneider Electric Software Update (SESU) regularly to

obtain the latest EcoStruxure Machine Expert updates.
• Launch the Schneider Electric Software Installer to obtain information on

new features available for installation.
• Also visit regularly the Schneider Electric website to download the latest

device firmware available.
In specific situations, you may encounter compatibility concerns regarding these
updates, and actions are required to establish consistency with your existing
systems and project files for the following elements:

• EcoStruxure Machine Expert files created with a previous EcoStruxure
Machine Expert version, or SoMachine and SoMachine Motion versions (for
example, projects, archives, exports)

• Device firmware versions (for example, controllers, HMI terminals)
• Related software (for example, Vijeo-Designer)

EcoStruxure Machine Expert Software

By installing a new version of EcoStruxure Machine Expert, new component
versions are available, which include:

Component Description

Compiler version The compiler is the software that converts your project into the binary code that
is downloaded and executed on the controller.

The compiler is called when you execute a Build, Build All, Rebuild, or
Generate Code action in EcoStruxure Machine Expert. The version of the
compiler used is independent of your EcoStruxure Machine Expert version and
can be defined by selecting: Project > Project Settings > Compile options

By default, the latest compiler version is selected.

Device
description
version

The device description defines the properties of a device such as
configurability, programmability, and possible connections to other devices.

When you insert a device inside a project, EcoStruxure Machine Expert uses
the device description to define the properties of the device.

The device description version is displayed in the Information tab of the device
editor (see EcoStruxure Machine Expert, Programming Guide).

Library version A library is a container of variable lists, data structures (DUTs), functions, and
function blocks (POU) that can be used in your projects. The versions of
libraries used in an application are visible in the Library Manager (see
EcoStruxure Machine Expert, Functions and Libraries User Guide).

EIO0000002842.04 9
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There are 2 types of project files which are created by EcoStruxure Machine
Expert:

File type Description

*.project

*.library

The version of a EcoStruxure Machine Expert project/library file is determined
by the application file version and the application profile.

• Project format version:
The version of the application file is defined by the version of EcoStruxure
Machine Expert that saved this application file. It acts as a container that
specifies the storage format for the content of the application.

• Project categories:
Defines the versions of device descriptions, the versions of the libraries
used, the compiler version, the visualization profile, and the visualization
styles versions (refer to Visualization part of EcoStruxure Machine Expert
online help). The application profile applies to the applications of the
project/library.

*.projectarchive A project archive can be created by using EcoStruxure Machine Expert and be
saved on your PC as a *.projectarchive file. This file contains one project and
can contain download information files, referenced devices, referenced
libraries, the visualization profile, and the visualization styles.

You can also do a source download to create an archive as an Archive.prj file in
your controller.

The following elements can have compatibility concerns between EcoStruxure
Machine Expert or SoMachine / SoMachine Motion versions:

• Project files, page 11
• Archives files, page 11
• Device firmware, page 16
• Vijeo-Designer software, page 27

Device Firmware

The firmware is the software embedded in the controller.

The firmware version is displayed in the EcoStruxure Machine Expert Logic
Builder Communication Settings tab of the device editor (see EcoStruxure
Machine Expert, Programming Guide) associated to your controller.

Vijeo-Designer Software

The Vijeo-Designer software allows you to create your HMI applications.

The EcoStruxure Machine Expert installation includes the installation files of Vijeo-
Designer and can be installed or updated without the EcoStruxure Machine Expert
software, but cannot be used without the EcoStruxure Machine Expert software.

For compatibility information with Vijeo-Designer, refer to the section Compatibility
of EcoStruxure Machine Expert and Vijeo-Designer Versions, page 27.

EcoStruxure Operator Terminal Expert Software

The EcoStruxure Operator Terminal Expert software allows you to create your
HMI applications.

EcoStruxure Operator Terminal Expert can be installed from the Schneider
Electric Software Installer by clicking Install Software and selecting the product
EcoStruxure Operator Terminal Expert.

For compatibility information, refer to the online help of EcoStruxure Operator
Terminal Expert.

10 EIO0000002842.04
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Compatibility Situations

Overview
This chapter provides information on compatibility situations you may encounter
when you install a new version of the EcoStruxure Machine Expert software,
acquire a new device or a new version of Vijeo-Designer software.

Using a New Version of EcoStruxure Machine Expert Software

Overview

This section describes the compatibility situations you may encounter when
installing a new version of EcoStruxure Machine Expert.

Refer to the Schneider Electric Software Installer User Guide for information about
the installation procedure.

Using Existing SoMachine, SoMachine Motion or EcoStruxure Machine Expert Projects

Overview

With EcoStruxure Machine Expert, you can open existing projects that were
created with SoMachine, SoMachine Motion or a previous version of EcoStruxure
Machine Expert. In the course of this manual, such projects will be referred to as
legacy projects.

You can use legacy projects (created with SoMachine, SoMachine Motion or a
previous version of EcoStruxure Machine Expert) in different ways:

• Open a *.project file
• Extract Archive a *.projectarchive file
• Source Upload a *.prj file from a controller

Using a project archive is the preferred method for migrating a project because a .
projectarchive file contains the following additional information that is not included
in a .project file:

• Download information file
• Libraries
• Device description files

When you extract the archive in EcoStruxure Machine Expert, the device and
library files can automatically be installed into the corresponding EcoStruxure
Machine Expert repositories.

Update Project Dialog Box

When you open a legacy project, the Update Project dialog box is displayed. It
provides an Overview tab and additional tabs, depending on the elements of the
project that need to be updated.

EIO0000002842.04 11
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The Overview tab provides general information:

Element Description

Project format version
information area

Provides information on the present version of the project format and the
new version and indicates whether an Upgrade or a Downgrade is to be
performed. Further information on the upgrade or downgrade operation
is provided by the information box that is displayed upon mouse rollover
on the i symbol.

Project features not
supported by your
installation area

Provides a list of project features that are not supported by the present
EcoStruxure Machine Expert installation on your PC (for example,
because a specific Add-on is not installed).

Project categories
available for update
area

Lists the project categories that need to be updated and provides a short
overview. For further information, refer to the tabs specific to each
category.

By default, the categories are selected for update. To exclude a category
from the update operation, deselect the check box.

Check for updates
when opening this
project option

The Check for updates when opening this project option is by default
selected.

Deactivate the option to prevent the search for updates when you open
the project. To reactivate the function later on, open the Update Project
dialog box from Logic Builder by executing the command Project >
Open “Update Project” dialog....

Restore
recommended update
settings button

After you have made modifications on this dialog box, this button is
enabled. Click the Restore recommended update settings button to
return to the default settings.

12 EIO0000002842.04
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Element Description

Update button Click the Update button to perform the update according to the settings
made in this dialog box.

Result: The content of the project will be updated. When a controller is
no longer supported and needs to be replaced, it will be converted into a
supported device. If no replacement device is available, the device will
neither be updated nor converted. It will still be available but it cannot be
used in the project in EcoStruxure Machine Expert.

NOTE: After you have updated a project or a project archive, you
cannot open it with SoMachine, SoMachine Motion or a previous
version of EcoStruxure Machine Expert.

Cancel button Click Cancel if you do not want to make any modifications to your
project.

NOTE: If your project contains devices that are not supported by
EcoStruxure Machine Expert, you can open the project with
EcoStruxure Machine Expert for copying parts of the project into a
new project. Nevertheless, compilation of this project is not
possible.

The tabs of the Update Project dialog box are displayed if the respective
elements of the project need to be updated. Each tab provides an option on top
that allows you to consider the specific element for update or to exclude the
element from the update procedure. Furthermore, detailed information is provided
on the update procedure and allows you to select your preferences.

• Compiler Version
The compiler is the software that converts your project into the binary code
that is downloaded and executed on the controller. For further information on
the compiler version, refer to the chapters General Information, page 9 and to
EcoStruxure Machine Expert/CoDeSys Compiler Version Mapping, page 33.
For a list of compiler messages, refer to the Compiler Errors document.

• Devices
Installed devices that require an update are listed with name, type, and
version. The suggested update action is listed in the Recommended column.
The Update to / Convert to column allows you to select the target version or
target device to be updated to or to be converted to from a list.
◦ If there is no target device listed in this column, the device has become

unsupported and cannot be replaced by a controller for the present
EcoStruxure Machine Expert version. The earlier version that supports this
device is listed in the Recommended column.

◦ If another controller is listed in the Update to / Convert to column, the
controller has become unsupported and needs to be converted to the
target controller.

For further information, see the list of unsupported devices, page 42 in the
Appendix of this User Guide, and refer to the updating devices part (see
EcoStruxure Machine Expert, Programming Guide) or the converting devices
part (see EcoStruxure Machine Expert, Programming Guide) of the online
help.

NOTE: If a controller is converted into another controller, the subdevices
are not converted. You have to verify them carefully and replace them
manually after the project has been converted.

The Status column displays symbols indicating information on the present
selection, compared to the Recommended state.

• Libraries
For further information on updating libraries, refer to the Functions and
Libraries User Guide (see EcoStruxure Machine Expert, Functions and
Libraries User Guide).

• Visualization profile
The Visualization profile defines:
◦ The names and versions of the Visualization Libraries that are included

in the project when a visualization object is created.
◦ A selection of visualization elements provided by the included libraries.

EIO0000002842.04 13
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• Visualization Styles
A visualization style is a collection of colors, fonts, images, and values that
are defined as style properties. These style properties are available when
designing visualization elements in order to help create a uniform, style-
dependent appearance.

For detailed information, refer to the Visualization part of the EcoStruxure Machine
Expert online help.

After you have confirmed your settings by clicking the Update button, perform a
build and a download of the project to the controller for the update to become
valid.

NOTE: Errors that are detected during the update process are displayed in the
Messages view of Logic Builder.
NOTE: After the update of the project,

• You may encounter device firmware compatibility issues, page 16,
• You will no longer be able to open the project in SoMachine, SoMachine

Motion or a previous version of EcoStruxure Machine Expert.
NOTE: You can still update your project at a later point in time by executing
the command Project > Open “Update Project” dialog..., and selecting the
Check for updates when opening this project option.
NOTE: You can open projects that contain unsupported devices, page 42 with
EcoStruxure Machine Expert, but you cannot edit them. EcoStruxure Machine
Expert requests you to convert to another platform.
NOTE:

• If a SoMachine or SoMachine Motion project with HMIs is loaded, it may
occur that Vijeo-Designer must be started by the update. In this case, it
may occur that Vijeo-Designer is only started in the background.
Vijeo-Designer must be opened manually to continue the update.

• If a SoMachine or SoMachine Motion project with unsupported HMIs is
loaded, it may occur that Vijeo-Designer is started and you are prompted
to enter a reference number.
If the reference number is not available, click No and the device is
updated automatically to a preprogrammed type.

• If a SoMachine or SoMachine Motion project with unsupported HMIs (with
control) is loaded, the HMI is converted in Vijeo-Designer to a supported
HMI.

NOTE: Even if you deselect the option Update Libraries, it may occur that
some libraries are updated. This is a result of the Update Devices procedure.
The libraries referenced by the device descriptions of the devices selected for
update are updated automatically if the Update Devices option is selected.

Using Your Legacy Projects

It is possible to install full versions of SoMachine, SoMachine Motion, or
EcoStruxure Machine Expert (available via DVD or USB) in parallel.

There is no need to uninstall an existing version before you start the installation of
a new version.

If you do not intend to use the latest features and functions of the new
EcoStruxure Machine Expert version, open your project with the version it was
created with.

Using Your Legacy Projects Without Update in EcoStruxure
Machine Expert

If you do not want to modify your project and still want to be able to connect to a
controller to which the original project was downloaded, click Cancel in the
Update Project dialog box.

14 EIO0000002842.04
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NOTE: If your project contains unsupported devices, page 42, you can open
the project with EcoStruxure Machine Expert for copying parts of the project
into a new project. Nevertheless, compilation of this project is not possible.
NOTE: If you do not update your project, the latest functionalities of
EcoStruxure Machine Expert are not available. Further, you might encounter
that the object code that would be generated by the present version of
EcoStruxure Machine Expert would differ from the object code generated by
SoMachine, SoMachine Motion or a previous version of EcoStruxure Machine
Expert from which the project was originally built. In this case, you will be
prompted by a message asking you to confirm that you do not want to update
your project.

WARNING
UNINTENDED EQUIPMENT OPERATION
• Always verify that your application program will operate as it had under any

previous compiler version within SoMachine, SoMachine Motion or
EcoStruxure Machine Expert.

• Thoroughly test a newly compiled version of your application with the device
firmware compatible with the latest version of EcoStruxure Machine Expert.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

To help ensure full compatibility of your original project, use the corresponding
version of SoMachine, SoMachine Motion or EcoStruxure Machine Expert
(installation may be required). For more information on how to reduce the effect of
a new version of EcoStruxure Machine Expert on your projects, refer to the
Settings Helping to Preserve Compatibility, page 18.

You can log in to your controller without building and downloading the project only
if a Download Information Files file (*.compileinfo) was created in the same
directory as the project on your PC.

Refer to Code Generation, Compile Information in the Building and Downloading
Applications chapter of the EcoStruxure Machine Expert Programming Guide.

Updating / Converting Single Devices Individually

If you click Cancel in the Update Project dialog box, the devices in your project
are not updated or converted.

To update or convert single devices individually, refer to the updating devices part
(see EcoStruxure Machine Expert, Programming Guide) or the converting devices
part (see EcoStruxure Machine Expert, Programming Guide) of the online help.

Using Legacy Repositories

To use repositories (for example device repositories, library repositories) of a
SoMachine / SoMachine Motion or previous EcoStruxure Machine Expert version
installed in parallel to your present EcoStruxure Machine Expert version, proceed
as follows:

Step Action Comment

1 In EcoStruxure Machine Expert Logic
Builder, execute the command Tools >
Options....

The Options dialog box is displayed.

2 Select Directories (Devices, Libraries, ...)
in the list on the left-hand side.

The Directories (Devices, Libraries,
...) dialog box of the EcoStruxure
Machine Expert Logic Builder is
displayed.

3 Activate the Include legacy repositories
check box.

Now you can use the legacy repositories
in your EcoStruxure Machine Expert
project.

EIO0000002842.04 15
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Vijeo-Designer Compatibility

The Vijeo-Designer software has its own rules which are defined in Vijeo-Designer
(Help > User Manuals > 3 Before You Begin > 3.2 Compatibility).

Vijeo-Designer can open an application created by an earlier version and can
automatically convert this application into the new version.

NOTE: The converted application can no longer be opened with an earlier
version of Vijeo-Designer.

EcoStruxure Operator Terminal Expert Compatibility

For compatibility information, refer to the online help of EcoStruxure Operator
Terminal Expert.

Projects with External Elements

If you did not follow the migration practices, page 18 when using SoMachine,
SoMachine Motion, or a previous version of EcoStruxure Machine Expert, you
may encounter the following concerns with external elements:

• A project that contains a device description installed from an EDS file, such
that the device cannot be recognized by the new EcoStruxure Machine
Expert version. You must install the device in the Device Repository,

• A project that contains a library (for example, a library created by the user)
that is not part of the EcoStruxure Machine Expert installation, such that the
library cannot be recognized by the new EcoStruxure Machine Expert
version. You must add the library in the Library Repository.

Creating a Project in EcoStruxure Machine Expert

Overview

When you create a project in EcoStruxure Machine Expert:
• You may encounter device firmware compatibility, page 16 concerns.
• You will not be able to open the project in SoMachine or SoMachine Motion

because it detects that the project is incompatible.
• You may not be able to open the project with earlier versions of EcoStruxure

Machine Expert because it detects that the project is incompatible.

Using a Device with an Earlier Firmware Version

Overview

When logging in or downloading a project with a new version of EcoStruxure
Machine Expert, you may encounter a compatibility concern with your controller
firmware:

In this message, the selected version is the device description version of the
active application; the online version is the firmware version of the controller.
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In this case, updating the device firmware is necessary. Device firmware is
provided with the EcoStruxure Machine Expert installation (managed by the
Schneider Electric Software Installer) or can be found on the Schneider Electric
website.

Refer to the Settings Helping to Preserve Compatibility, page 18 to understand
how to avoid this situation in future versions of EcoStruxure Machine Expert.

Refer to the chapter Compatibility of Controller and Device Description Versions,
page 24 to understand the compatibility rules (which device version can be
downloaded to which controller firmware version).

Using a New Controller

Using a New Controller

Overview

Schneider Electric updates the controller frequently providing new features and
functions. Therefore, there may be a difference between the version you receive
as a new product, the present version being put into stock from the factory, and
the version of your EcoStruxure Machine Expert installation.

Controller with an Earlier Firmware Version

You received a controller with a firmware version earlier than the one of the
devices in your EcoStruxure Machine Expert project.

In this case, updating the controller firmware is necessary. Controller firmware is
provided inside the EcoStruxure Machine Expert installation or can be found on
the Schneider Electric website.

If you do not update your controller, you are able to log in to your controller only if
the compatibility rule is respected, page 24.

Controller with a Later Firmware Version

You may receive a controller with a firmware version later than one of the devices
in your EcoStruxure Machine Expert project.

In this case, updating the project, page 11 is necessary.

Alternatively, consider downgrading the firmware of your controller.

In general, you are able to log in to your controller only if the compatibility rule is
respected, page 24.

Controller Running a Solution Project (S-Type)

If your controller is running a SoMachine V3.1 solution project, use one of the
following options:

• Update, page 11 your SoMachine V3.1 solution project to EcoStruxure
Machine Expert, and update the controller firmware compatible to your
EcoStruxure Machine Expert version. For details, refer to the EcoStruxure
Machine Expert Release Notes.

• Change the firmware of the controller by the new firmware supporting the
application libraries. Device firmware is provided with the EcoStruxure
Machine Expert installation (managed by the Schneider Electric Software
Installer) or can be found on the Schneider Electric website.

Also refer to the not supported application libraries, page 52.

Also refer to Compatibility of Legacy S-Type Devices, page 28.
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Migration Considerations

Migration Considerations

Project Archives Helping to Preserve Compatibility

Overview

Before you install a new version of EcoStruxure Machine Expert software, or when
your project is completed, it is a good practice to create an archive of your project.
The archive contains all files included and referenced in the project with settings
and profiles.

Project archives provide the following advantages:
• You can extract the project archive to any computer with EcoStruxure

Machine Expert installed. In this way, you can share your projects with others
or run it on another computer.

• Creating an archive can help reduce compatibility concerns with later
versions of EcoStruxure Machine Expert.

This chapter provides information on the specific settings that help to preserve
compatibility.

For information on creating project archives, refer to the description of the File >
Project Archive > Save/Send Archive... command in the EcoStruxure Machine
Expert Menu Commands Online Help.

NOTE: Unsupported devices, page 42 are not installed on the local system
and are therefore not available in the Device Repository dialog box.

Settings Helping to Preserve Compatibility

When you create an archive on your local computer by executing the File >
Project Archive > Save/Send Archive... command, the Project Archive dialog
box opens.

In the Project Archive dialog box, the following topics can affect compatibility and
therefore you can select them when appropriate:

Information Description

Download information
files

When this is selected, the compile information (the *.compileinfo file) is
saved with your project file.

This allows you to log in to the controllers with the archived project without
rebuilding the project.

Referenced devices When this is selected, the devices in the Device Repository of your
project are saved into the archive with their versions.

Devices installed with EDS files are included.

Referenced libraries When this is selected, the libraries in the Library Repository of your
project are saved into the archive with their versions.

Third-party libraries are included.
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Compatibility Annexe
What’s in This Chapter
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EcoStruxure Machine Expert/CoDeSys Compiler Version Mapping ...................33

Overview
This section provides the annexes regarding the compatibility between
EcoStruxure Machine Expert versions.

Compatibility between Controllers / Modules / Bus Couplers /
Cartridges

Introduction

This section provides the compatibilities between the different devices:
• Controllers
• Modules
• Bus Couplers
• Cartridges

Compatibility Controllers / TM2 and TM3 Modules

Reference TM241

TM251

TM262 PacDrive 3 LMC Eco

PacDrive 3 LMC Pro

PacDrive 3 LMC Pro 2

TM2A• 1, 2 1 –

TM2D• 1, 2 1 –

TM3D• 1, 2 1, 2 –

TM3A• 1, 2 1, 2 –

TM3S• 1, 2 1, 2 –

TM3T• 1, 2 1, 2 –

TM3XTYS4 1, 2 1, 2 –

TM3XHSC202 2 2 –
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Reference TM241

TM251

TM262 PacDrive 3 LMC Eco

PacDrive 3 LMC Pro

PacDrive 3 LMC Pro 2

TM3XHSC202G 2 2 –

TM3XFHSC202 – 2 –

TM3XFHSC202G – 2 –

TM3XTRA1 1, 2 1, 2 –

TM3XREC1 1, 2 1, 2 –

1 Compatible via TM3BCEIP, TM3BCSL and TM3BCCO

2 Compatible when connected to the controller (local architecture)

Compatibility Controllers / TM4 and TMS Modules

Reference TM241

TM251

TM262 PacDrive 3 LMC Eco

PacDrive 3 LMC Pro

PacDrive 3 LMC Pro 2

TM4ES4 ✓ – –

TM4PDPS1 ✓ – –

TMSES4 – ✓ –

TMSCO1 – ✓ –

Compatibility Controllers / TMC4 Cartridges

Reference TM241 TM251

TM262

PacDrive 3 LMC Eco

PacDrive 3 LMC Pro

PacDrive 3 LMC Pro 2

TMC4AI2 ✓ – –

TMC4TI2 ✓ – –

TMC4AQ2 ✓ – –

TMC4HOIS01 ✓ – –

TMC4PACK01 ✓ – –

Compatibility Controllers / TM5 Modules

Reference TM241

TM251

TM262M• TM262L• PacDrive 3 LMC Eco

PacDrive 3 LMC Pro

PacDrive 3 LMC Pro 2

TM5SAI2L 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5SAI2H 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5SAI4L 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5SAI4H 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5SAI2PH 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5SAI2TH 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5SAI4PH 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5SAI6TH 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5SAO2L 2, 6 1, 3, 4, 6 3, 4, 6 1, 6
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Reference TM241

TM251

TM262M• TM262L• PacDrive 3 LMC Eco

PacDrive 3 LMC Pro

PacDrive 3 LMC Pro 2

TM5SAO2H 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5SAO4L 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5SAO4H 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5C24D18T 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5C12D8T 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5C12D6T6L 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5C24D12R 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5CAI8O8VL 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5CAI8O8CL 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5CAI8O8CVL 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5SDI2D 2, 6 1, 3, 4, 6 3, 4, 6 1

TM5SDI4D 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5SDI4A 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5SDI6D 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5SDI6U 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5SDI12D 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5SDI16D 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5SDI2A 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5SDO2T 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5SDO2S 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5SDO2R 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5SDO4T 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5SDO4TA 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5SDO4R 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5SDO6T 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5SDO8TA 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5SDO12T 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5SDO16T 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5SEAISG 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5SE1IC02505 6 1, 6 6 1, 6

TM5SE1SC10005 6 1, 6 6 1, 6

TM5SE1IC20005 2 – – 1

TM5SE1IC01024 6 1, 6 6 1, 6

TM5SE2IC01024 6 1, 6 6 1, 6

TM5SDI2DF 2, 6 1, 6 6 1, 6

TM5SMM6D2L 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5SDM12DT 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5SPDG12F 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5SPDD12F 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5SPDG5D4F 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5SPDG6D6F 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5SPS1• 2, 6 1, 3, 4, 6 3, 4, 6 1, 6
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Reference TM241

TM251

TM262M• TM262L• PacDrive 3 LMC Eco

PacDrive 3 LMC Pro

PacDrive 3 LMC Pro 2

TM5SPS1F 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5SPS2 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5SPS2F 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5SPS3 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5SBER2 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5SBET1 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5SBET7 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5SD000 2, 6 1, 3, 4, 6 3, 4, 6 1, 6

TM5SE1RS2 – 1 – 1

TM5SE1MISC20005 – – – 1

TM5SDM8DTS – – – 1

TM5CSLC•00FS – 5 – 5

TM5SDM4DTRFS – 1 – 1

TM5SAI4AFS – 1 – 1

TM5STI4ATCFS – 1 – 1

TM5SDI2DFS – 1 – 1

TM5SDI4DFS – 1 – 1

TM5SDI20DFS – 1 – 1

TM5SDM8TBFS – 1 – 1

TM5SDO2TAFS – 1 – 1

TM5SDO2TFS – 1 – 1

TM5SDO2DTRFS – 1 – 1

TM5SDO4TAFS – 1 – 1

TM5SDO4TFS – 1 – 1

TM5SDO6TBFS – 1 – 1

TM5SDC1FS – 1 – 1

TM5SPS10FS – 1 – 1

1 Compatible via TM5NS31

2 Compatible via TM5NCO1 + TM7NCOM•

3 Compatible via TMSCO1 + TM5NCO1

4 Compatible via TMSCO1 + TM7NCOM•

5 Compatible directly connected on Sercos

6 Compatible via TM5NEIP1

Compatibility Controllers / TM7 Modules

Reference TM241

TM251

TM262M• TM262L• PacDrive 3 LMC Eco

PacDrive 3 LMC Pro

PacDrive 3 LMC Pro 2

TM7BA•• 2, 3, 6 2, 4, 5 2, 4, 5 1, 2

TM7BD•• 2, 3, 6 2, 4, 5 2, 4, 5 1, 2

TM7SPS1A 2, 3, 6 2, 4, 5 2, 4, 5 1, 2

TM7SDM12DTFS – 1 – 1
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Reference TM241

TM251

TM262M• TM262L• PacDrive 3 LMC Eco

PacDrive 3 LMC Pro

PacDrive 3 LMC Pro 2

TM7SDI8DFS – 1 – 1

1 Compatible via TM5NS31 + TM5SBET7

2 Compatible via TM5NEIP1 + TM5SBET7

3 Compatible via TM5NCO1 + TM5SBET7

4 Compatible via TMSCO1 + TM5NCO1 + TM5SBET7

5 Compatible via TMSCO1 + TM7NCOM•

6 Compatible via TM7NCOM•

Compatibility of Controller and Device Description Versions

Overview

Logic controller firmware and device description versions are made of four digits:
X.Y.Z.T.

An Application.app file can be downloaded to a controller if the device description
used to create this file is compatible with the controller firmware.

Compatibility Rule

The controller firmware and the device description are compatible if the following
rules are respected:

• X.Y digits must be identical
• The Z digit of the controller must be greater or equal to the Z digit from the

device description.
• T digit is irrelevant

Example

A device description version 2.0.20.30 of a controller is compatible with the
following controller firmware versions:

• 2.0.20.11
• 2.0.20.14
• 2.0.20.30
• 2.0.30.13
• 2.0.31.3

But it is not compatible with the firmware versions 2.0.10.8.

Compatibility of Device User Management

Overview

The user rights storage format is updated with EcoStruxure Machine Expert V2.0.

User rights included in controllers programmed with EcoStruxure Machine Expert
versions prior to V2.0 must be recreated after updating their firmware version to
EcoStruxure Machine Expert V2.0.
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Compatibility of Lexium 62 Servo Drives and Programming
Software Versions

Overview

Lexium 62 devices are available for use with SoMachine Motion or EcoStruxure
Machine Expert.

Some of the new functions of Lexium 62 servo drives are only available in
EcoStruxure Machine Expert as they require a hardware revision and the related
product firmware version.

The compatibility table indicates the relation of hardware and programming
software versions.

Compatibility Table for Servo Drives all Variants LXM62DU••• and LXM62DD•••

Commercial
reference

Hardware
revision(1)

Safety-related
functions

SoMachine Motion versions EcoStruxure
Machine Expert
versions

V1.0...3.0 V3.1...4.2 V4.3 ...4.4 SP2 V1.1, V1.2 and
V2.0

LXM62DU••C /
LXM62DD••C

RS0• STO (Safe
Torque Off)
hardwired

YES YES YES YES(3)

LXM62DU••D /
LXM62DD••D

LXM62DU••E /
LXM62DD••E

Safety via
Sercos bus

NO NO YES YES(3)

LXM62DU••F /
LXM62DD••F

LXM62P – YES YES YES YES(3)

LXM62DU••C /
LXM62DD••C

RS1• STO hardwired NO YES(2) YES YES

LXM62DU••D /
LXM62DD••D

LXM62DU••E /
LXM62DD••E

Safety via
Sercos bus

NO NO YES YES(3)

LXM62DU••F /
LXM62DD••F

LXM62DU••G /
LXM62DD••G

STO hardwired NO NO NO YES

LXM62P – NO YES(2) YES YES(3)

(1) See Nameplate Descriptions in the Lexium 62 Hardware Guide (see Lexium 62, Hardware Guide)

(2) FDR (Fast Device Replacement) with SoMachine Motion V3.1 is only possible if a firmware SoMachine Motion V3.1...4.4 SP2 is
installed in the drive

(3) Limited to SoMachine Motion V4.4 SP1 features without the new features listed below

Safety via Sercos bus These drives support STO (Safe Torque Off) hardwired, controlled via digital input, plus the safety-related functions
STO, SLS, SS1, SS2... controlled via Sercos.

YES Supported

NO Not compatible
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Compatibility Table for Servo Drives LXM62DC13•

Commercial
reference

Hardware
revision(1)

Safety-
related
functions

SoMachine Motion versions EcoStruxure Machine Expert
versions

V1.0...3.0 V3.1...4.2 V4.3 ...4.4
SP2

V1.1 and V1.2 V2.0

LXM62DC13C RS0• STO
hardwired

YES YES YES YES(3) YES(3)

LXM62DC13E Safety via
Sercos bus

NO NO YES YES(3) YES(3)

LXM62DC13C RS1• STO
hardwired

NO YES(2) YES YES(3) YES

LXM62DC13E Safety via
Sercos bus

NO NO YES YES(3) YES(3)

LXM62DC13G STO
hardwired

NO NO NO NO YES

(1) See Nameplate Descriptions in the Lexium 62 Hardware Guide (see Lexium 62, Hardware Guide)

(2) FDR (Fast Device Replacement) with SoMachine Motion V3.1 is only possible if a firmware SoMachine Motion V3.1...4.4 SP2 is
installed in the drive

(3) Limited to SoMachine Motion V4.4 SP1 features without the new features listed below

Safety via Sercos bus These drives support STO (Safe Torque Off) hardwired, controlled via digital input, plus the safety-related functions
STO, SLS, SS1, SS2... controlled via Sercos.

YES Supported

NO Not compatible

New features compatible with EcoStruxure Machine Expert V1.1:
• Torque control
• Brake release check
• Encoderless velocity control with BMP synchronous motors
• Machine encoder input
• Incremental encoder output (encoder simulation)

New feature compatible with EcoStruxure Machine Expert V1.2:
• Lexium 62 servo drives supporting SH3 motors with Hiperface-DSL encoder

and OneCable connection.
New feature compatible with EcoStruxure Machine Expert V2.0:

• Lexium 62 servo drives DC13 High Current Support for more than 90 A.
NOTE: The support of high currents > 90 A only affects LXM62DC13 in all
variants. There is no influence on other devices.

Compatibility of HMI and Controller Versions

Overview

When building a solution with some HMI and controllers communicating to each
other, you must use controllers and HMI devices at the same firmware / runtime
compatibility level.

When you download an application with an HMI from EcoStruxure Machine
Expert, the HMI runtime is automatically updated to the latest version.
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NOTICE
COMMUNICATION INTERRUPTION

Do not use a different controller firmware version or a different HMI runtime
other than that which is delivered with the Vijeo-Designer version specified in
the Release Notes for the given EcoStruxure Machine Expert version.

Failure to follow these instructions can result in equipment damage.

Refer to the EcoStruxure Machine Expert Release Notes for the relation between
the EcoStruxure Machine Expert version, the controller firmware, and Vijeo-
Designer.

Compatibility of EcoStruxure Machine Expert and Vijeo-Designer
Versions

Overview

If you want to use Vijeo-Designer with EcoStruxure Machine Expert, you should
not use a different version from the one provided with EcoStruxure Machine
Expert.

The table provides the Vijeo-Designer version for each EcoStruxure Machine
Expert version:

EcoStruxure Machine Expert Version V1.1 /
V1.1SP1

V1.2 /
V1.2.x

V2.0

Vijeo-Designer Version 6.2.8.4008 6.2 SP9.1 6.2 SP11.1

For compatibility of SoMachine and SoMachine Motion versions with Vijeo-
Designer versions, refer to the corresponding Compatibility and Migration User
Guide of those software products.

Compatibility of EcoStruxure Machine Expert and EcoStruxure
Operator Terminal Expert Versions

Overview

The table provides the EcoStruxure Operator Terminal Expert version for each
EcoStruxure Machine Expert version:

EcoStruxure Machine Expert Version V2.0

EcoStruxure Operator Terminal Expert Version 3.2

Compatibility of EcoStruxure Machine Expert Projects Using DTM
Devices

Overview

Generally the DTM design supports only one DTM of a certain version on a PC.

Installing DTMs

Before you open a project using DTM devices, you have to install the respective
DTMs using Schneider Electric Software Installer.
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Launching EcoStruxure Machine Expert and Updating the Device Repository

Step Action Comment

1 After installing the DTMs, launch EcoStruxure
Machine Expert.

The DTM Repository dialog box is
displayed showing a list of new
DTMs found.

2 Select the DTMs you want to import to the
Device Repository.

This is done by activating the check
boxes in the Scan column.

3 Click Import selected DTMs. The selected DTMs are imported to
the Device Repository.

Opening and Updating Your Project

Step Action Comment

1 After updating the Device Repository, open
your project.

The Update Project dialog box is
displayed.

2 Click Update in the Update Project dialog box. The devices (and DTMs) are
updated.

Compatibility of Legacy S-Type Devices

Overview

With EcoStruxure Machine Expert, legacy S-Type controllers are not supported.

Also refer to section Using a New Controller, page 17.

Replacement of S-Type Devices

After opening a project containing S-type devices, the Update Project dialog box,
page 11 lists the legacy devices (S-type), and in a second column the associated
generic devices (G-type).

Click OK to convert the legacy devices to the associated generic devices
automatically.

Legacy S-Type Devices Converted to G-Type Devices

M258 controllers

TM258LF42DTS0 TM258LF42DT

TM258LF42DT4LS0 TM258LF42DT4L

TM258LF66DT4LS0 TM258LF66DT4

TM258LF42DRS0 TM258LF42DR

LMC058 controllers

LMC058LF42S0 LMC058LF42

LMC058LF424S0 LMC058LF424

Compatibility of Controller Connection Mechanism

Overview

To connect to a controller, different mechanisms are supported. For detailed
information, refer to the respective chapters in the EcoStruxure Machine Expert
Programming Guide (Communication Settings in Controller Selection Mode,
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Restrictions for SoMachine / SoMachine Motion Controllers

For SoMachine / SoMachine Motion controllers (firmware compatible to
SoMachine V3.1 and earlier), the following functionalities are available:

• Find controller.
• Select controller.
• Connect controller.

For SoMachine / SoMachine Motion controllers (firmware compatible to
SoMachine V3.1 and earlier), the following functionalities are not available:

• Identify controller.
• Get information.

Compatibility of Namespaces

Overview

EcoStruxure Machine Expert provides a feature by which for some libraries it is
mandatory to specify a namespace in front of each symbol used out of this library.

For details, refer to Namespace (see EcoStruxure Machine Expert, Functions and
Libraries User Guide) in the EcoStruxure Machine Expert Functions and Libraries
User Guide.

Therefore, after updating a project from a SoMachine version earlier than V4.0,
you might encounter undeclared symbol compiler error messages.

To solve this, write the corresponding namespace, followed by a dot, in front of the
undeclared symbol.

Example:

GET_STATE –> CIA405.GET_STATE.

Compatibility of Libraries

Overview

It is possible to manage concurrent communication of EtherNet/IP and Modbus
TCP devices with the controller, for example TM251MESE. To make the libraries
independent from the device network, the libraries, used to control some devices,
have been updated in order to have the same namespace whatever the device
network protocol used to control them.

Therefore, after updating a project from a SoMachine version, the following
compiler error messages can be displayed:

• Unknown type: SEMFDP…
• Unknown type: SEMFDM…

These messages are raised if your application was controlling the following
devices on Modbus TCP:

• Lexium 32
• Altivar 32
• Altivar 71
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Updating Your Project

During the update, two libraries are automatically replaced by other libraries:

The libraries... ...are replaced by...

• FieldbusDevicesModbusTcp, and
• FieldbusDevicesPLCOpen

• GMC Independent Lexium,
• GMC Independent ModbusTCP,
• GMC Independent Altivar, and
• GMC Independent PLCOpen MC.

Once the project is updated, you have to perform the following replacements:

If the application was
using…

…replace the deprecated
namespace…

…by the new namespace…

PLCopen function blocks
(name starting with MC_)

SEMFDP

(FieldbusDevicesPLCopen)

GIPLC

(GMC Independent PLCopen MC)

Vendor-specific function
blocks for Altivar (name
ending with _ATV)

SEMFDM

(FieldbusDevicesMod-
busTCP)

GIATV

(GMC Independent Altivar)

Vendor-specific function
blocks for Lexium (name
ending with _LXM)

SEMFDM

(FieldbusDevicesMod-
busTCP)

GILXM

(GMC Independent Lexium)

For more information on the namespace, refer to General Description of Libraries
(see EcoStruxure Machine Expert, Functions and Libraries User Guide).

Compatibility Limitations

Updating SoMachine V1.1 Projects

Update SoMachine V1.1 projects in a first step to SoMachine V3.1. After that,
update to theEcoStruxure Machine Expert version.

Updating a SoMachine V3.1 Project to EcoStruxure Machine Expert Has Influences on
DTMs

After updating a project made in SoMachine V3.1 to EcoStruxure Machine Expert,
the Advantys OTB DTM and the TM5-7 DTM may be unresponsive or unreliable.

If this happens, copy and paste the same DTM. The new node will work fine.

You can then remove the old DTM node.

New Process of Retrieving the State of CANopen Slaves with EcoStruxure Machine
Expert

In SoMachine V3.1 it was possible to use internal variables implicitly created when
adding a CANopen slave to access some information on the state of the device.
For example, MyOTB.nStatus or MyOTB.bSlaveAvailable.

These internal structures are no longer supported in EcoStruxure Machine Expert.
Instead, use the GET_STATE function blocks of the CIA405 library to retrieve the
state of your CANopen slaves.

Mapping Variables on Single Bits Feature Only for EcoStruxure Machine Expert

The feature that allows you to map variables on single bits is only available for
devices that have been created with EcoStruxure Machine Expert.
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In EcoStruxure Machine Expert projects that have been updated from a version
earlier than SoMachine V4.0, this feature is not available for the existing / updated
devices.

To make the feature available for these devices, create a new device node and
delete the old one.

3S CanOpenStack Library

If you use the 3S CanOpenStack library in your project, the following Build error
may be detected and displayed in the Messages view:

C0035: Program name or function block instance expected instead of 'xxx'.
where 'xxx' is a POU inside your project (for example, a POU named START or
STOP).

As the library 3S CanOpenStack is of the category Intern (not intended for direct
usage), it is a best practice to enable the option Only allow qualified access to
all identifiers in the Properties dialog box of this library for overcoming the Build
error.

Variables Defined in GVL of a Library Not Correctly Shared After Updating SoMachine
V3.1 Projects

When you update a SoMachine V3.1 project, the message The POU xxx is no
longer available within your compiled application but it is still configured in
the symbol configuration may be displayed in the Messages view. It indicates
that variables defined in a GVL of a library are not correctly shared in the symbol
configuration editor (see EcoStruxure Machine Expert, Programming Guide).

To share again this variable in the symbol configuration, proceed as follows:

Step Action

1 Double-click the Symbol Configuration node in the Tools tree to open the symbol
configuration editor inside the updated project in your EcoStruxure Machine Expert
version.

2 Deselect the variable that is not correctly shared.

3 Close the symbol configuration editor.

4 Reopen the symbol configuration editor.

5 Build the application.

6 Select the variable again in the symbol configuration editor.

Connecting to Controllers in Remote Subnets

In SoMachine V3.1, a Remote Connection tool is available for connecting to
controllers in remote subnets.

In EcoStruxure Machine Expert, connections to controllers in remote subnets are
established with the Communication Settings tab in controller selection mode of
the device editor (see EcoStruxure Machine Expert, Programming Guide) by using
the Connection Mode types for Remote TCP. For connections via OPC, use the
Static Remote Connections tab of the Gateway Management Console.

In EcoStruxure Machine Expert, connections to controllers in remote subnets can
be established from the Static Remote Connections tab of the Gateway
Management Console. To open the Gateway Management Console, right-click the
gateway icon in the Windows notification area. For further information, refer to the
Gateway Management Console User Guide online help.
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Direct Addresses of Type myvar AT %Mn : BOOL Cause Error Messages

When you build a SoMachine or SoMachine Motion application (created with
SoMachine V3.1 or earlier), with EcoStruxure Machine Expert, the message
Direct Address %M?n malformed may be displayed if you use direct addresses
of the type myvar AT %Mn : BOOL in your variable declarations.

You can skip this message by selecting Ignore.

In any case, this usage will lead to Build errors that will be displayed in the
Messages view.

To avoid these Build errors, replace the address declaration by the type myvar
AT %MXn.0 : BOOL.

EtherNet/IP Adapter Removed During Update

If you have defined an M251 MESE EtherNet/IP adapter function on an
Ethernet#1 connector in an application built with SoMachine V4.1 SP1 or earlier,
and you intend to convert this application to a later version, then the EtherNet/IP
adapter previously configured will be deleted.

Limitations for SoMachine V4.1 SP2 or V4.2 Applications Including the EtherNet/IP
Adapter Service

Starting from firmware V4.0.4.x (SoMachine V4.1 SP2) for M251MESE and
V4.0.5.x (SoMachine V4.2) for M241 and M251MESC, the EtherNet/IP adapter
service has the following limitations:

• The File Object is removed.
• The Modbus Object is removed.
• The value displayed for the RPI (Requested Packet Interval) parameter is not

valid for M251MESE with SoMachine earlier than V4.1SP2 and for M241 with
SoMachine earlier than V4.2.

• The RUN/IDLE status of the PLC_R structure is not valid.
• The UCMM (Unconnected Message Manager) Error Count and Class 3 Error

Count of the PLC_R structure are not valid.

Different Behavior of the TM3 Bus When Updating SoMachine V4.2 Applications to
SoMachine V4.3

When you update an application from SoMachine V4.2 to EcoStruxure Machine
Expert, this may lead to a different M241 Logic Controller / M251 Logic Controller
behavior on the TM3 bus:

SoMachine version Default behavior if an error is
detected

Default value of Parameter
TM3_BUS_W_IOBUSERRMOD

V4.2 I/O exchanges continue on the
TM3 bus.

IOBUS_ERR_PASSIVE

V4.3 I/O exchanges are stopped on the
TM3 bus by the logic controller.

IOBUS_ERR_ACTIVE

To preserve the behavior of SoMachine V4.2, set the parameter TM3_BUS_W_
IOBUSERRMOD to IOBUS_ERR_PASSIVE. For further information, refer to the
M241 / M251 PLCSystem Library Guide (see Modicon M251 Logic Controller,
System Functions and Variables, PLCSystem Library Guide).

Modbus IOScanner for Serial Line: Read/Write (FUNC23) Is Not Transformed
Automatically

Read/Write (FUNC23) used in Modbus IOScanner for Serial Line in SoMachine
V3.1 or earlier is not automatically transformed to Read (FUNC03) and Write
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(FUNC16) in EcoStruxure Machine Expert if the slave does not support the Read/
Write function.

Modify the application manually by separating the Read/Write function into one
Read and one Write.

Devices Imported from EDS Files Are Not Updated

Whenever you update a SoMachine or SoMachine Motion project file containing
devices for which no new device description files are installed in the present
EcoStruxure Machine Expert device repository, these devices are not recognized
by EcoStruxure Machine Expert. This applies in particular to devices imported
from EDS files.

To avoid this, install these devices before updating your project. For further
information, refer to the chapters Using Existing SoMachine or SoMachine Motion
Projects with EcoStruxure Machine Expert, page 11 and Migration Considerations,
page 18.

Updating Library Parameters of a POU

If you have renamed parameters of a POU for a library between versions, the old
parameter names will still be used in the POU code.

In order to use the new parameter names, execute the Update Parameters
command manually on the corresponding POU call usage.

For a description of this command, refer to the SoMachine Menu Commands
Online Help section of the EcoStruxure Machine Expert Online Help.

Slider on Web Visualization Corrupted

When updating a project created with SoMachine or EcoStruxure Machine Expert
V1.2.x or earlier versions, slider elements used in Web Visualizations may be
displayed without a scale.

This is because, for compatibility reasons, existing sliders are not updated
automatically during the project update. To update the element manually, update
the scale proportion property of the slider by editing the property and accepting
the present value.

For sliders without a scale, the show scale property has to be temporarily set.

EcoStruxure Machine Expert/CoDeSys Compiler Version Mapping

Overview

The following mapping table gives an overview of which CoDeSys compiler
version is used by default in a certain EcoStruxure Machine Expert or SoMachine
or SoMachine Motion version.

SoMachine

SoMachine Software Version Mapped Display Version CoDeSys Compiler
Version

SoMachine V1.0 V1.0.10.0 3.2.2.43

SoMachine V1.1 V1.1.10.0 3.3.1.2

SoMachine V2.0 RL1 V2.0.18.8 3.3.1.40

SoMachine V2.0 RL2 V2.0.20.20 3.3.1.40

SoMachine V3.0 V3.0.14.5 3.4.1.50

SoMachine V3.1 V3.1.10.1 3.4.1.90

SoMachine V4.0 V4.0.0.0 3.5.3.60
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SoMachine Software Version Mapped Display Version CoDeSys Compiler
Version

SoMachine V4.1 V4.1.0.0 3.5.3.82

SoMachine V4.1 SP1 V4.1.0.1 3.5.3.83

SoMachine V4.1 SP1.1 V4.1.0.2 3.5.3.84

SoMachine V4.1 SP1.2 V4.1.0.3 3.5.3.85

SoMachine V4.1 SP2 V4.1.0.4 3.5.3.86

SoMachine V4.2 V4.1.0.4 3.5.3.86

SoMachine V4.3 V4.1.0.5 3.5.3.87

SoMachine Motion

SoMachine Motion Software Version Mapped Display Version CoDeSys Compiler
Version

SoMachine Motion V1.0 V1.31.10.0 3.3.2.10

SoMachine Motion V1.1 V1.32.19.0 3.4.0.21

SoMachine Motion V1.2 V1.33.19.0 3.4.1.16

SoMachine Motion V3.0 V1.34.25.0 3.4.3.22

SoMachine Motion V3.1 V1.35.20.0 3.4.4.30

SoMachine Motion V3.1 SP1 V1.36.35.0 3.5.1.41

SoMachine Motion V4.0 V4.0.0.0 3.5.3.40

SoMachine Motion V4.1 V4.1.0.0 3.5.3.130

SoMachine Motion V4.2 V4.2.0.0 3.5.6.52

SoMachine Motion V4.3 SP1 V4.31.0.0 3.5.7.70

SoMachine Motion V4.4 V4.4.0.0 3.5.10.52

SoMachine Motion V4.4 SP1 V4.41.0.0 3.5.10.100

EcoStruxure Machine Expert

EcoStruxure Machine Expert
Software Version

Mapped Display Version CoDeSys Compiler
Version

EcoStruxure Machine Expert V1.1 Machine Expert V1.1
(V1.1.0.0)

3.5.12.80

EcoStruxure Machine Expert V1.1 SP1 Machine Expert V1.1 SP1
(V1.1.1.0)

3.5.12.82

EcoStruxure Machine Expert V1.2 /
V1.2.x

Machine Expert V1.1 SP1 /
V1.2 (V1.11.0.0)

3.5.12.82

EcoStruxure Machine Expert V2.0 Machine Expert V2.0 3.5.16.84

The mapped display version is used for example in the Project Settings >
Compile Options dialog and the Update Project dialog box.
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Conversion of ATV32 to ATV320 Devices

Overview

Convert an ATV32 device configuration to an ATV320 device configuration by
using the SoMove configuration software. As a prerequisite, the configuration file
(*.psx) corresponding to the ATV32 device to convert is required.

Procedure Overview

The migration of ATV32 to ATV320 devices is performed in three steps that are
described in this document:

Step Action

1 Generating the ATV32 configuration file (*.psx), page 35.

2 Converting the ATV32 device configuration to an ATV320 device configuration, page
36.

3 Importing the converted ATV320 project into EcoStruxure Machine Expert, page 36.

How to Generate the ATV32 Configuration File

The following procedure describes how to generate the ATV32 configuration file
(*.psx) directly from the device by using SoMove V2.6 or later:

Step Action Result

1 Launch SoMove. The SoMove start page opens.

2 Execute the command Tools > Edit
Connection / Scan.

–

3 In the Edit Connection dialog box, select the
connection settings that correspond to the ATV32
device you want to convert. For further
information, refer to the SoMove online help.

–

4 Click Apply. The Edit Connection dialog box is
closed.

5 Execute the command Transfer > Load from
Device from the SoMove start page.

–

6 Select a file to save the SoMove project. –

7 Select the file type SoMove project files (*.psx). –

8 Click Save. The upload process starts.
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How to Convert ATV32 to ATV320 Devices

To convert an ATV32 to an ATV320 device, perform the following steps:

Step Action Result

1 Launch SoMove. The SoMove start page opens.

2 Execute the command Tools > Device
Conversion.

The Device Conversion dialog box
opens.

3 Select the ATV32 configuration file (*.psx) that
you want to convert, and click Open.

The Device Conversion for ATV32
dialog box opens.

4 Select ATV320 from the Select Target list and
click Convert.

The Select ATV320 dialog box
opens.

5 Select the option ATV320 Book or ATV320
Compact according to your requirements.

The compatible Reference,
Firmware Version, Supply
Voltage, and Nominal Power
parameters are displayed for the
selected option.

6 Click OK. The message Device conversion
is successful is displayed.

7 Click OK to close the message. The converted ATV320 project
opens.

How to Import the Converted ATV320 Project Into EcoStruxure Machine Expert

To import the converted ATV320 device configuration into EcoStruxure Machine
Expert, perform the following steps:

Step Action Result

1 Launch SoMove. The SoMove start page opens.

2 Execute the command Tools > Edit
Connection / Scan.

–

3 In the Edit Connection dialog box, select the
connection settings that correspond to the
ATV320 device you want to update. For further
information, refer to the SoMove online help.

–

4 Click Apply. The Edit Connection dialog box is
closed.

5 Execute the command Transfer > Store to
Device.

–

6 Close SoMove. –

7 Open your EcoStruxure Machine Expert project,
and select Altivar 320 in the Devices tree.

–

8 Upload the device configuration for the ATV320
device. For more information, refer to the Device
Type Manager (DTM) - User Guide (see
EcoStruxure Machine Expert, Device Type
Manager (DTM), User Guide).

–

Replacing an ATV32 by an ATV320 Without Modifying the
EcoStruxure Machine Expert Project

Procedure Overview

Replacing an ATV32 by an ATV320 device is performed in six steps that are
described in this document:
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Step Action

1 Verify if it is necessary to activate the compatibility mode ATV32 in the ATV320. For
further information, refer to the paragraphs of this map describing How to Verify
Whether the Compatibility Mode ATV32 Must be Activated, page 37 for the different
field buses.

2 Convert the ATV32 device configuration to an ATV320 device configuration.

3 Transfer the converted ATV320 device configuration to the ATV320 device.

4 Replace the ATV32 device by an ATV320 device.

5 Activate the compatibility mode ATV32 in the ATV320, if required. For further
information, refer to the paragraphs of this map describing the different ways to activate
the compatibility mode ATV32 in the ATV320, page 38.

6 Save the ATV320 to the fast device replacement (FDR) server if you intend to use this
feature.

How to Verify Whether the Compatibility Mode ATV32 Must be Activated

The following procedure describes the three initial steps that need to be performed
to verify whether the compatibility mode must be activated. The subsequent steps
depend on the fieldbus you are using. They are listed in separate paragraphs:

Step Action Result

1 Open the EcoStruxure Machine Expert project
and navigate to the ATV32 node in the Devices
tree.

–

2 Double-click the ATV32 node. The device configuration view is
displayed.

3 Verify the settings as described in the following
paragraphs:

• On CANopen, page 37.
• On EtherNet/IP, page 37.
• On Modbus TCP, page 38.

–

How to Verify Whether the Compatibility Mode ATV32 Must be Activated on CANopen

Perform the following steps on CANopen to verify whether the compatibility mode
must be activated:

Step Action Result

1 Select the check box Enable Expert Settings. The CANopen Remote Device tab
is extended to display further
parameters.

2 Verify the check boxes in the Checks at Startup
section:

• Check Product Number
• Check Revision Number

–

If... Then ...

If the check box Check Product Number is
selected,

Then you need to activate the compatibility
mode ATV32 in the ATV320.

If the check box Check Revision Number is
selected,

Then you will probably not be able to replace the
device without modifying the EcoStruxure
Machine Expert project.

How to Verify Whether the Compatibility Mode ATV32 Must be Activated on EtherNet/IP

Perform the following step on EtherNet/IP to verify whether the compatibility mode
must be activated:
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Step Action Result

1 In the device configuration view, open the Target
settings tab.

–

2 Verify the check boxes:
• Check Product Code
• Check Major Revision
• Check Minor Revision

–

If... Then ...

If the check box Check Product Code is
selected,

Then you need to activate the compatibility
mode ATV32 in the ATV320.

If the check boxes Check Major Revision and /
or Check Minor Revision are selected,

Then you will probably not be able to replace the
device without modifying the EcoStruxure
Machine Expert project.

How to Verify Whether the Compatibility Mode ATV32 Must be Activated on Modbus
TCP

It is not necessary to activate the compatibility mode ATV32 in the ATV320 on
Modbus TCP.

How to Activate the Compatibility Mode ATV32 in the ATV320

The following paragraphs describe the different ways to activate the compatibility
mode ATV32 in the ATV320:

• Using a Modbus SL client software, page 38.
• Using a CANopen client software, page 38.
• Using the graphical keypad of the ATV320, page 39.
NOTE: It is not possible to activate the compatibility mode ATV32 by using
SoMove or the local keypad.

Activating the Compatibility Mode ATV32 Using a Modbus SL Client Software

Proceed as follows to activate the compatibility mode ATV32 using a Modbus SL
client software:

Step Action

1 Write the word d#1 to the parameter AP17 having the address d#8817 to the ATV320
device over Modbus SL.

2 Save the modification in EEPROM by writing the word d#2 to the parameter CMI
having the address d#8504.

NOTE:
• Use d#0 for AP17 for the default ATV320 mode.
• Use d#1 for AP17 in order to activate the ATV32 mode.

Activating the Compatibility Mode ATV32 Using a CANopen Client Software

Proceed as follows to activate the compatibility mode ATV32 using a CANopen
client software:

Step Action

1 Write the word d#1 to the parameter AP17 having the address (index:subindex) =
16#203A:16#12 to the ATV320 device over CANopen.

2 Save the modification in EEPROM by writing the value d#2 to the parameter CMI
having the address (index:subindex) = 16#2037:16#5.
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NOTE:
• Use d#0 for AP17 for the default ATV320 mode.
• Use d#1 for AP17 in order to activate the ATV32 mode.

Activating the Compatibility Mode ATV32 Using the Graphical Keypad of the ATV320

Proceed as follows to activate the compatibility mode ATV32 using the graphical
keypad of the ATV320:

Step Action

1 Select the entry 2. IDENTIFICATION.

2 Place the cursor on the Graphic Display Terminal > <version>.

3 Push the ENTER button for 5 s until the graphic keypad has returned to the menu 2.
IDENTIFICATION.

4 Select the entry 1.3 CONF.

5 Select the entry FULL.

6 Select the entry HWO (= MenuHiddenWords).

7 Select the entry APW (= MenuApplicativeHiddenWords).

8 Select Application 17, and write d#1.

NOTE:
• Use d#0 for Application 17 for the default ATV320 mode.
• Use d#1 for Application 17 in order to activate the ATV32 mode.

Replacing an Advantys OTB Distributed I/O System by a TM3 Bus
Coupler

Hardware Migration

Conversion proposal:

OTB Reference Input
used

Output
used

Counter
PWM/PLS

Width
(mm)

Substitute References Input Output Width
(mm)

OTB1E0DM9LP 4 4 0 55 TM3BCEIP + TM3DM8R/G 4 4 51

OTB1E0DM9LP 12 8 0 55 TM3BCEIP + TM3DM24R/G 16 8 66

OTB1S0DM9LP 4 4 0 55 TM3BCSL + TM3DM8R/G 4 4 51

OTB1S0DM9LP 12 8 0 55 TM3BCSL + TM3DM24R/G 16 8 66

OTB1C0DM9LP 4 4 0 55 TM3BCCO + TM3DM8R/G 4 4 51

OTB1C0DM9LP 12 8 0 55 TM3BCCO + TM3DM24R/G 16 8 66

OTB1E0DM9LP 12 8 4 55 TM221M32K 16 16 70

OTB1E0DM9LP 12 8 4 55 TM221M32K 16 16 70

OTB1C0DM9LP 12 8 4 55 TM241CEC24• 14 10 150

Migration Conditions

This table describes the features that can be migrated:

Application type and features Substitute with TM3 Bus Coupler

OTB using embedded counter No substitution

OTB using embedded PLS No substitution
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Application type and features Substitute with TM3 Bus Coupler

OTB using embedded PMW No substitution

OTB using embedded I/Os TM3BC + TM3DM24R or TM3DM24R expansion modules

OTB using Remote Fast Counter (RFC) No substitution

OTB using Remote Very Fast Counter (RVFC) No substitution

OTB using Remote Pulse Generator Output (RPLS) No substitution

OTB using Remote Pulse Width Modulator (RPWM) No substitution

Compatibility Table

Software used Application Migration to EcoStruxure Machine Expert V2.0

Hardware Compatibility Software Compatibility

SoMachine V4.3 YES Modify the controller application

EcoStruxure Machine Expert V1.• YES Modify the controller application

Unity using Advantys YES –

3rd party using Advantys YES –

Ethernet: replacing a OTB1E0DM9LP by a TM3BCEIP

OTB1E0DM9LP TM3BCEIP

General Features

Ethernet connector RJ45 2 RJ45 daisy chain

Bus Speed (Mbps) 10, 100 10, 100

Protocol EIP Not supported Supported

Protocol Modbus TCP Supported Supported

Plug and Work (Discovery) Not supported Supported

Fast Device Replacement (FDR) Not supported Supported

Manufacturer zone Modbus Registers

0 Status of Module inputs Supported Not supported

1...99 Status of Module inputs Supported Supported

100 Status of Module inputs Supported Not supported

101...199 Modules output commands Supported Supported

200...599 Modules I/O configuration parameters Supported Not supported

600...699 Remote Fast Counter (RFC) Supported Not supported

700...799 Remote Very Fast Counter (RVFC) Supported Not supported

800...899 Remote pulse generator function
(RPLS))

Supported Not supported

900...999 System diagnostics Supported Supports only 900-901, 930-933, 990-
991

1000...1049 Managing the island’s behavior Supported Supports only 1005, 1009

1050...1099 managing the TCP connection Supported Supports only 1058-1066

1100...1108 Description of modules constituting
the island

Supported Supported (1)

2507... 2508 TM3 bus coupler product firmware
version

Not supported Supported

2512... 2513 TM3 bus coupler product serial
number

Not supported Supported
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OTB1E0DM9LP TM3BCEIP

2601 Rotary switch ONES position Not supported Supported

2602 Rotary switch TENS position Not supported Supported

1 1100 represents the bus coupler product code.

Serial Line: replacing a OTB1S0DM9LP by a TM3BCSL

OTB1S0DM9LP TM3BCSL

General Features

Serial connector RJ45 2 RJ45 daisy chain

Bus Speed (bits/s) 1200, 2400, 4800, 9600, 19200, 38400 1200, 2400, 4800, 9600, 19200, 38400,
57600, 115200

Parity Even Even

Data format 8 bits, 1 stop bit 8 bits, 1 stop bit

Manufacturer zone Modbus Registers

0 Status of Module inputs Supported Not supported

1...99 Status of Module inputs Supported Supported

100 Modules output commands Supported Supported

101...199 Status of Module inputs Supported Supported

200...599 Modules I/O configuration
parameters

Supported Not supported

600...699 Remote Fast Counter (RFC) Supported Not supported

700...799 Remote Very Fast Counter (RVFC) Supported Not supported

800...899 Remote pulse generator function
(RPLS))

Supported Not supported

900...999 System diagnostics Supported Supports only 900-901,930-933

1000...1099 Managing the module behavior Supported Supports only 1005, 1009, 1050-1054

1100...1108 Description of modules
constituting the island

Supported Supported

CANopen: replacing a OTB1C0DM9LP by a TM3BCCO

OTB1C0DM9LP TM3BCCO

General Features

CANopen connector 1 D-Sub DB9 2 RJ45 daisy chain

Bus Speed (Kbits/s) 10, 20, 50, 125, 250, 500, 800, 1000 20, 50, 125, 250, 500, 800, 1000

Event Timer timeout Not supported Supported

Remote Transmission Request of PDOs Not supported Supported

Communication Objects

1010: Store Parameters Supported Not supported

1011: Restore Default Parameters Supported Not supported

1029: Error Behavior Not supported Supported

1201: Second Server SDO Parameter Not supported Supported

1400 & 1600: Receive PDOs (RxPDOs) Supports up to 8 RxPDOs Supports up to 29 RxPDOs

1800 & 1A00: Transmit PDOs (TxPDOs) Supports up to 8 TxPDOs Supports up to 56 TxPDOs

Manufacturer-specific Objects
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OTB1C0DM9LP TM3BCCO

IO Modules configuration Dedicated Objects for each module
configuration

Single Object for all Modules
configuration

Analog Modules Diagnostics Object 3000 Object 2300

Device-specific Objects

6002: Digital Input 8 bits: polarity Not supported Supported

6006: Digital Input 8 bits: interrupt mask Not supported Supported

6103: Digital Input 16 bits: Filter mask Supported Not supported

6106: Digital Input 16 bits: interrupt mask Not supported Supported

6202: Digital Output 8 bits: polarity Not supported Supported

6306: Fallback Mode Output 16 bits Supported Not supported (fallback is managed via
the TM3 configuration)

6307: Fallback Value Output 16 bits Supported Not supported (fallback is managed via
the TM3 configuration)

6308: Digital Output 16 bits: Filter mask Supported Not supported

6443: Analog Output Fallback Mode Supported Not supported (fallback is managed via
the TM3 configuration)

6307: Analog Output Fallback Value Supported Not supported (fallback is managed via
the TM3 configuration)

Replacing an OTB1E0DM9LP by a TM3BCEIP from a SoMachine
V4.3 project to an EcoStruxure Machine Expert Project

Follow these steps to replace a OTB1E0DM9LP by a TM3BCEIP from a
SoMachine V4.3 project to an EcoStruxure Machine Expert Project

Step Action

1 Open your SoMachine V4.3 project in EcoStruxure Machine Expert V2.0 and click
update.

2 Select TM3BCEIP in the Hardware Catalog and drag it to the Devices tree under the
Ethernet Network node.

3 In the Modbus TCP Slave Configuration window, select the same Ethernet parameter
for TM3BCEIP than you have in the OTB_1E0DM9LP.

4 Select the TM3DM24R/G in the Hardware Catalog and drag it to the Devices tree
under the TM3BC_EtherNetIP (TM3BCEIP).

5 Select the TM2 expansion modules under the OTB_1E0DM9LP then right-click and
select Cut.

6 Select the TM3BC_EtherNetIP (TM3BCEIP) in the Devices tree and right-click Paste.

Result: The TM2 expansion modules are connected to the TM3BCEIP.

7 Open the OTB_1E0DM9LP Modbus IOScanner I/O Mapping tab and the
TM3DM24R/G Modbus IOScanner I/O Mapping tab and copy the Inputs variables
from the OTB_1E0DM9LP to the TM3DM24R/G.

8 Copy the Outputs variables from the OTB_1E0DM9LP to the TM3DM24R/G.

9 Select the OTB_1E0DM9LP and right-click Delete

Unsupported Devices

Unsupported Devices

The table lists the devices that are not supported by the present EcoStruxure
Machine Expert version. The second column provides the devices that are
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proposed for conversion in the Devices tab of the Update Project dialog box,
page 11. If the second column is empty, no device is available for replacement in
the present EcoStruxure Machine Expert version.

Unsupported device Converted to

TM238LDA24DR TM241C24R

TM238LDD24DT TM241C24T/U

TM238LFAC24DR TM241CEC24R/U

TM238LFDC24DT TM241CEC24T/U

TM258LD42DT –

TM258LD42DT4L –

TM258LF42DT –

TM258LF42DT4L –

TM258LF66DT4L –

TM258LF42DR –

LMC058LF42 –

LMC058LF424 –

LMC078 –

ATV-IMC –

Lexium05 –

Lexium23+ –

ATV32 ATV320

ATV31/ATV312 ATV320

ATV71: 220 V and 400 V ATV340/ATV930, for details see the ATV71
References Substitution List, page 45

ATV71: 690 Vac ATV930, for details see the ATV71 References
Substitution List, page 45

Osicoder –

OTB1E0DM9LP TM3BCEIP+TM3DM8R/G

TM3BCEIP+TM3DM24R/G

TM221ME32TK

OTB1S0DM9LP TM3BCSL+TM3DM8R/G

TM3BCSL+TM3DM24R/G

TM221M32K

OTB1C0DM9LP TM3BCCO+TM3DM8R/G

TM3BCCO+TM3DM24R/G

TM241CEC24•

FTB –

ASI Master / ASI Slaves –

iEM3x50 –

PM1200 –

PM325• –

PM800 –

Harmony HMISTO••••••• version monochrome Harmony HMIS5T

Harmony HMIXBTGK•••• Harmony HMIGK••••

HMIG5U Box –

Harmony HMIXBTGT1••5 Harmony HMIGTO••••

Harmony HMIXBTGT2•••
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Unsupported device Converted to

Harmony HMIXBTGT4••• Harmony HMIGTO•••• / Harmony HMIGTU••••
(HMIG3U box)

Harmony HMIXBTGT5•••

Harmony HMIXBTGT6•••

Harmony HMIXBTGT7••• Harmony HMIGTU•••• (HMIG3U box)

HMIBPxxx2/xxx5 HMIBMP

HMIBSO HMIBMI

HMIBSU HMIBMO

HMIBUxxx1/xxx• HMIBMU

HMIGTW5354/PWC5 Harmony HMIGTU•••• (HMIG3U box)

HMIGTW7354x/PWC7/PVC7

HMIPPx6 HMIBMP

HMIIPPx7/PRx7

HMIPPx9

HMIPUx6 HMIBMU

HMIIPUx7/PRx7 HMIBMU/P

HMIPUx9 HMIBMU

HMIBMO –

HMIBMI –

HMIBSC –

XBTGT + control –

XBTGK + control –

XBTGC –

NOTE: The Modicon M221 Logic Controller which was previously supported
within SoMachine via SoMachine Basic is not integrated into EcoStruxure
Machine Expert.

The Update Project procedure may include a conversion of devices as indicated
in the list.

The conversion of devices may also have influences on the addressing and the
libraries.

To help to avoid unintended behavior after a device was converted:
• Verify that the new device supports all functions and communication ports

that are required in your project.
• Avoid using direct addresses in your application.
• Perform a backup of the project to the PC before converting a device:

WARNING
UNINTENDED EQUIPMENT OPERATION
• Verify that any direct addresses used in your application (for example, %IB5)

have been converted correctly after device conversion.
• Verify that the modified project contains the intended configurations and

provides the intended functionality after you have converted the device.
Failure to follow these instructions can result in death, serious injury, or
equipment damage.
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NOTICE
LOSS OF DATA

Perform a backup of the project to the PC before converting a device.

Failure to follow these instructions can result in equipment damage.

ATV71 References Substitution List

Unsupported Reference Substitute References

- Option 1 Option 2

ATV71H037M3 ATV930U07M3 -

ATV71H037M3383 ATV930U07M3 -

ATV71H037M3460 - -

ATV71H037M3S337 ATV930U07M3 -

ATV71H037M3Z ATV930U07M3 -

ATV71H075M3 ATV930U15M3 -

ATV71H075M3383 ATV930U15M3 -

ATV71H075M3460 - -

ATV71H075M3S337 ATV930U15M3 -

ATV71H075M3Z ATV930U15M3 -

ATV71H075N4 ATV930U15N4 ATV340U07N4

ATV71H075N4383 ATV930U15N4 ATV340U07N4

ATV71H075N4460 - -

ATV71H075N4S337 ATV930U15N4 ATV340U07N4

ATV71H075N4Z ATV340U07N4 ATV930U15N4Z

ATV71H075N4Z460 - -

ATV71HC11N4 ATV930C13N4C -

ATV71HC11N4381 - -

ATV71HC11N4383 ATV930C13N4C -

ATV71HC11N4D ATV930C13N4C -

ATV71HC11Y ATV9A0C16*6 -

ATV71HC11YT ATV9A0C16*6 -

ATV71HC13N4 ATV930C16N4C -

ATV71HC13N4381 - -

ATV71HC13N4383 ATV9A0C71*4 -

ATV71HC13N4D ATV930C16N4C -

ATV71HC13Y ATV9A0C20*6 -

ATV71HC13YT ATV9A0C20*6 -

ATV71HC16N4 ATV930C22N4C ATV930C20N4F

ATV71HC16N4381 - -

ATV71HC16N4383 ATV930C22N4C ATV930C20N4F

ATV71HC16N4D ATV930C22N4C ATV930C20N4F

ATV71HC16Y ATV9A0C25*6 -

ATV71HC16YT ATV9A0C25*6 -

ATV71HC20N4 ATV930C25N4C ATV930C25N4F

ATV71HC20N4381 - -

ATV71HC20N4383 ATV930C25N4C ATV930C25N4F
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Unsupported Reference Substitute References

ATV71HC20N4D ATV930C25N4C ATV930C25N4F

ATV71HC20Y ATV9A0C31*6 -

ATV71HC20YT ATV9A0C31*6 -

ATV71HC25N4 ATV930C31N4C ATV930C31N4F

ATV71HC25N4381 - -

ATV71HC25N4383 ATV930C31N4C ATV930C31N4F

ATV71HC25N4D ATV930C31N4C ATV930C31N4F

ATV71HC25Y ATV9A0C40*6 -

ATV71HC25YT ATV9A0C40*6 -

ATV71HC28N4 ATV9A0C40*4 -

ATV71HC28N4381 - -

ATV71HC28N4383 ATV9A0C40*4 -

ATV71HC28N4D ATV9A0C40*4 -

ATV71HC31N4 ATV9A0C45*4 -

ATV71HC31N4381 - -

ATV71HC31N4383 ATV9A0C45*4 -

ATV71HC31N4D ATV9A0C45*4 -

ATV71HC31Y ATV9A0C50*6 -

ATV71HC31YT ATV9A0C50*6 -

ATV71HC40N4 ATV9A0C56*4 -

ATV71HC40N4381 - -

ATV71HC40N4383 ATV9A0C56*4 -

ATV71HC40N4D ATV9A0C56*4 -

ATV71HC40Y ATV9A0C63*6 -

ATV71HC40YT ATV9A0C63*6 -

ATV71HC50N4 ATV9A0C71*4 -

ATV71HC50N4381 - -

ATV71HC50N4383 ATV9A0C71*4 -

ATV71HC50N4D ATV9A0C71*4 -

ATV71HC50Y ATV9A0C80*6 -

ATV71HC50YT ATV9A0C80*6 -

ATV71HC63Y ATV9A0M10*6 -

ATV71HC63YT ATV9A0M10*6 -

ATV71HD11M3X ATV930D15M3 -

ATV71HD11M3X337 ATV930D15M3 -

ATV71HD11M3X383 ATV930D15M3 -

ATV71HD11M3X460 - -

ATV71HD11M3XZ ATV930D15M3 -

ATV71HD11N4 ATV930D15N4 ATV340D11N4

ATV71HD11N4383 ATV930D15N4 ATV340D11N4

ATV71HD11N4460 - -

ATV71HD11N4S337 ATV930D15N4 ATV340D11N4

ATV71HD11N4Z ATV340D11N4 ATV930D15N4Z

ATV71HD11N4Z305 - -

ATV71HD11N4Z383 ATV340D11N4 ATV930D15N4Z

ATV71HD11N4Z460 - -
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Unsupported Reference Substitute References

ATV71HD11Y ATV930D15Y6 -

ATV71HD15M3X ATV930D18M3 -

ATV71HD15M3X337 ATV930D18M3 -

ATV71HD15M3X383 ATV930D18M3 -

ATV71HD15M3X460 - -

ATV71HD15M3XZ ATV930D18M3 -

ATV71HD15N4 ATV930D18N4 ATV340D15N4

ATV71HD15N4383 ATV930D18N4 ATV340D15N4

ATV71HD15N4460 - -

ATV71HD15N4S337 ATV930D18N4 ATV340D15N4

ATV71HD15N4Z ATV340D15N4 ATV930D18N4Z

ATV71HD15N4Z305 - -

ATV71HD15N4Z383 ATV340D15N4 ATV930D18N4Z

ATV71HD15N4Z460 - -

ATV71HD15Y ATV930D18Y6 -

ATV71HD18M3X ATV930D22M3 -

ATV71HD18M3X337 ATV930D22M3 -

ATV71HD18M3X383 ATV930D22M3 -

ATV71HD18M3X460 - -

ATV71HD18N4 ATV930D22N4 ATV340D18N4

ATV71HD18N4383 ATV930D22N4 ATV340D18N4

ATV71HD18N4460 - -

ATV71HD18N4S337 ATV930D22N4 ATV340D18N4

ATV71HD18N4Z ATV340D18N4 ATV930D22N4Z

ATV71HD18N4Z304 - -

ATV71HD18N4Z305 - -

ATV71HD18N4Z383 ATV340D18N4 ATV930D22N4Z

ATV71HD18N4Z460 - -

ATV71HD18Y ATV930D22Y6 -

ATV71HD22M3X ATV930D30M3 -

ATV71HD22M3X337 ATV930D30M3 -

ATV71HD22M3X383 ATV930D30M3 -

ATV71HD22M3X460 - -

ATV71HD22N4 ATV930D30N4 ATV340D22N4

ATV71HD22N4383 ATV930D30N4 ATV340D22N4

ATV71HD22N4460 - -

ATV71HD22N4S337 ATV930D30N4 ATV340D22N4

ATV71HD22N4Z ATV340D22N4 ATV930D30N4Z

ATV71HD22N4Z305 - -

ATV71HD22N4Z383 ATV340D22N4 ATV930D30N4Z

ATV71HD22N4Z460 - -

ATV71HD22Y ATV930D30Y6 -

ATV71HD30M3X ATV930D37M3 -

ATV71HD30M3X337 ATV930D37M3 -

ATV71HD30M3X383 ATV930D37M3 -

ATV71HD30M3X460 - -
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Unsupported Reference Substitute References

ATV71HD30N4 ATV930D37N4 ATV340D30N4E

ATV71HD30N4383 ATV930D37N4 ATV340D30N4E

ATV71HD30N4460 - -

ATV71HD30N4S337 ATV930D37N4 ATV340D30N4E

ATV71HD30N4Z ATV340D30N4E ATV930D37N4Z

ATV71HD30N4Z305 - -

ATV71HD30N4Z383 ATV340D30N4E ATV930D37N4Z

ATV71HD30N4Z460 - -

ATV71HD30Y ATV930D37Y6 -

ATV71HD37M3X ATV930D45M3 -

ATV71HD37M3X337 ATV930D45M3 -

ATV71HD37M3X383 ATV930D45M3 -

ATV71HD37M3X460 - -

ATV71HD37N4 ATV930D45N4 ATV340D37N4E

ATV71HD37N4383 ATV930D45N4 ATV340D37N4E

ATV71HD37N4460 - -

ATV71HD37N4S337 ATV930D45N4 ATV340D37N4E

ATV71HD37N4Z ATV340D37N4E ATV930D45N4Z

ATV71HD37N4Z305 - -

ATV71HD37N4Z383 ATV340D37N4E ATV930D45N4Z

ATV71HD37N4Z460 - -

ATV71HD37Y ATV930D45Y6 -

ATV71HD45M3X ATV930D55M3 -

ATV71HD45M3X337 ATV930D55M3 -

ATV71HD45M3X383 ATV930D55M3 -

ATV71HD45N4 ATV930D55N4 ATV340D45N4E

ATV71HD45N4383 ATV930D55N4 ATV340D45N4E

ATV71HD45N4S337 ATV930D55N4 ATV340D45N4E

ATV71HD45N4Z ATV340D45N4E ATV930D55N4Z

ATV71HD45N4Z383 ATV340D45N4E ATV930D55N4Z

ATV71HD45Y ATV930D55Y6 -

ATV71HD55M3X ATV930D75M3 -

ATV71HD55M3X383 ATV930D75M3 -

ATV71HD55M3XD ATV930D75M3 -

ATV71HD55N4 ATV930D75N4 ATV340D55N4E

ATV71HD55N4383 ATV930D75N4 ATV340D55N4E

ATV71HD55N4S337 ATV930D75N4 ATV340D55N4E

ATV71HD55N4Z ATV340D55N4E ATV930D75N4Z

ATV71HD55N4Z383 ATV340D55N4E ATV930D75N4Z

ATV71HD55Y ATV930D75Y6 -

ATV71HD75M3X ATV930D75M3 -

ATV71HD75M3X383 ATV930D75M3 -

ATV71HD75M3XD ATV930D75M3 -

ATV71HD75N4 ATV930D90N4 ATV340D75N4E

ATV71HD75N4383 ATV930D90N4 ATV340D75N4E

ATV71HD75N4S337 ATV930D90N4 ATV340D75N4E
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Unsupported Reference Substitute References

ATV71HD75N4Z ATV340D75N4E ATV930D90N4Z

ATV71HD75N4Z383 ATV340D75N4E ATV930D90N4Z

ATV71HD75Y ATV930D90Y6 -

ATV71HD90N4 ATV930C11N4C -

ATV71HD90N4381 - -

ATV71HD90N4383 ATV930C11N4C -

ATV71HD90N4D ATV930C11N4C -

ATV71HD90Y ATV9A0C13*6 -

ATV71HU15M3 ATV930U22M3 -

ATV71HU15M3383 ATV930U22M3 -

ATV71HU15M3460 - -

ATV71HU15M3S337 ATV930U22M3 -

ATV71HU15M3Z ATV930U22M3 -

ATV71HU15N4 ATV930U22N4 ATV340U15N4

ATV71HU15N4383 ATV930U22N4 ATV340U15N4

ATV71HU15N4460 - -

ATV71HU15N4S337 ATV930U22N4 ATV340U15N4

ATV71HU15N4Z ATV340U15N4 ATV930U22N4Z

ATV71HU15N4Z460 - -

ATV71HU15S6X ATV930U22S6X -

ATV71HU22M3 ATV930U30M3 -

ATV71HU22M3383 ATV930U30M3 -

ATV71HU22M3460 - -

ATV71HU22M3S337 ATV930U30M3 -

ATV71HU22M3Z ATV930U30M3 -

ATV71HU22N4 ATV930U30N4 ATV340U22N4

ATV71HU22N4383 ATV930U30N4 ATV340U22N4

ATV71HU22N4460 - -

ATV71HU22N4S337 ATV930U30N4 ATV340U22N4

ATV71HU22N4Z ATV340U22N4 ATV930U30N4Z

ATV71HU22N4Z383 ATV340U22N4 ATV930U30N4Z

ATV71HU22N4Z460 - -

ATV71HU22S6X ATV930U30S6X -

ATV71HU22Y ATV930U30Y6 -

ATV71HU30M3 ATV930U40M3 -

ATV71HU30M3383 ATV930U40M3 -

ATV71HU30M3460 - -

ATV71HU30M3S337 ATV930U40M3 -

ATV71HU30M3Z ATV930U40M3 -

ATV71HU30N4 ATV930U40N4 ATV340U30N4

ATV71HU30N4383 ATV930U40N4 ATV340U30N4

ATV71HU30N4460 - -

ATV71HU30N4S337 ATV930U40N4 ATV340U30N4

ATV71HU30N4Z ATV340U30N4 ATV930U40N4Z

ATV71HU30N4Z383 ATV340U30N4 ATV930U40N4Z

ATV71HU30N4Z460 - -
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Unsupported Reference Substitute References

ATV71HU30S6X ATV930U40S6X -

ATV71HU30Y ATV930U40Y6 -

ATV71HU40M3 ATV930U55M3 -

ATV71HU40M3383 ATV930U55M3 -

ATV71HU40M3460 - -

ATV71HU40M3S337 ATV930U55M3 -

ATV71HU40M3Z ATV930U55M3 -

ATV71HU40N4 ATV930U55N4 ATV340U40N4

ATV71HU40N4383 ATV930U55N4 ATV340U40N4

ATV71HU40N4460 - -

ATV71HU40N4S337 ATV930U55N4 ATV340U40N4

ATV71HU40N4Z ATV340U40N4 ATV930U55N4Z

ATV71HU40N4Z305 - -

ATV71HU40N4Z383 ATV340U40N4 ATV930U55N4Z

ATV71HU40N4Z460 - -

ATV71HU40S6X ATV930U55S6X -

ATV71HU40Y ATV930U55Y6 -

ATV71HU55M3 ATV930U75M3 -

ATV71HU55M3383 ATV930U75M3 -

ATV71HU55M3460 - -

ATV71HU55M3S337 ATV930U75M3 -

ATV71HU55M3Z ATV930U75M3 -

ATV71HU55N4 ATV930U75N4 ATV340U55N4

ATV71HU55N4383 ATV930U75N4 ATV340U55N4

ATV71HU55N4460 - -

ATV71HU55N4S337 ATV930U75N4 ATV340U55N4

ATV71HU55N4Z ATV340U55N4 ATV930U75N4Z

ATV71HU55N4Z305 - -

ATV71HU55N4Z383 ATV340U55N4 ATV930U75N4Z

ATV71HU55N4Z460 - -

ATV71HU55S6X ATV930U75S6X -

ATV71HU55Y ATV930U75Y6 -

ATV71HU75M3 ATV930D11M3 -

ATV71HU75M3383 ATV930D11M3 -

ATV71HU75M3460 - -

ATV71HU75M3S337 ATV930D11M3 -

ATV71HU75M3Z ATV930D11M3 -

ATV71HU75N4 ATV930D11N4 ATV340U75N4

ATV71HU75N4383 ATV930D11N4 ATV340U75N4

ATV71HU75N4460 - -

ATV71HU75N4S337 ATV930D11N4 ATV340U75N4

ATV71HU75N4Z ATV340U75N4 ATV930D11N4Z

ATV71HU75N4Z305 - -

ATV71HU75N4Z383 ATV340U75N4 ATV930D11N4Z

ATV71HU75N4Z460 - -

ATV71HU75S6X ATV930D11S6X -
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Unsupported Reference Substitute References

ATV71HU75Y ATV930D11Y6 -

ATV71LD11M3XZ ATV71LD54M3Z -

ATV71LD11N4Z ATV71LD27N4Z -

ATV71LD15M3XZ ATV71LD66M3Z -

ATV71LD15N4Z ATV71LD33N4Z -

ATV71LD18M3XZ - -

ATV71LD18N4Z - -

ATV71LD22M3XZ - -

ATV71LD22N4Z ATV71LD48N4Z -

ATV71LD30M3XZ - -

ATV71LD30N4Z - -

ATV71LD37M3XZ - -

ATV71LD37N4Z - -

ATV71LD45M3XZ - -

ATV71LD45N4Z - -

ATV71LD55N4Z - -

ATV71LD75N4Z - -

ATV71LU22M3Z - -

ATV71LU30M3Z - -

ATV71LU30N4Z - -

ATV71LU40M3Z - -

ATV71LU40N4Z ATV71LD10N4Z -

ATV71LU55M3Z ATV71LD27M3Z -

ATV71LU55N4Z ATV71LD14N4Z -

ATV71LU75M3Z ATV71LD33M3Z -

ATV71LU75N4Z ATV71LD17N4Z -

ATV71P075N4Z - -

ATV71PD11N4Z - -

ATV71PU15N4Z - -

ATV71PU22N4Z - -

ATV71PU30N4Z - -

ATV71PU40N4Z - -

ATV71PU55N4Z - -

ATV71PU75N4Z - -

ATV71W075N4 ATV950U07N4 ATV950U15N4

ATV71WD11N4 ATV950D11N4 ATV950D15N4

ATV71WD15N4 ATV950D15N4 ATV950D18N4

ATV71WD18N4 ATV950D18N4 ATV950D22N4

ATV71WD22N4 ATV950D22N4 ATV950D30N4

ATV71WD30N4 ATV950D30N4 ATV950D37N4

ATV71WD37N4 ATV950D37N4 ATV950D45N4

ATV71WD45N4 ATV950D45N4 ATV950D55N4

ATV71WD55N4 ATV950D55N4 ATV950D75N4

ATV71WD75N4 ATV950D75N4 ATV950D90N4

ATV71WU15N4 ATV950U15N4 ATV950U22N4

ATV71WU22N4 ATV950U22N4 ATV950U30N4
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Unsupported Reference Substitute References

ATV71WU30N4 ATV950U30N4 ATV950U40N4

ATV71WU40N4 ATV950U40N4 ATV950U55N4

ATV71WU55N4 ATV950U55N4 ATV950U75N4

ATV71WU75N4 ATV950U75N4 ATV950D11N4

Obsolete Libraries

Obsolete Libraries

The table lists the libraries that have become obsolete, i.e. that are no longer
supported by the present EcoStruxure Machine Expert version. The second
column provides the libraries available in the present EcoStruxure Machine Expert
version.

NOTE: The libraries that are listed in the second column are not fully
compatible with the obsolete libraries of the first column. When you update
your project from SoMachine / SoMachine Motion to EcoStruxure Machine
Expert, you must integrate the new libraries and adapt your application code
manually.

Obsolete library Present library

Altivar GMC IndependentMotion PLCopenMC

GMC IndependentMotion Altivar

CANmotion Lexium –

EnergyEfficiencyToolbox –

FieldBusDevicesBase GMC IndependentMotion Base

FieldBusDevicesItf GMC IndependentMotion Interface

FieldBusDevicesModbusTCP GMC IndependentMotion ModbusTCP

FieldBusDevicesPLCopen GMC IndependentMotion PLCopenMC

Integrated Lexium GMC IndependentMotion PLCopenMC

GMC IndependentMotion Lexium

Lexium GMC IndependentMotion PLCopenMC

GMC IndependentMotion Lexium

Lexium 23 Lexium 28

Lexium 32i GMC IndependentMotion PLCopenMC

GMC IndependentMotion Lexium

MachineEnergyDashboard –

ModbusEnergyEfficiencyToolbox –

Packaging –

PD_PacDriveLib_obsolete PD_PacDriveLib

PD_Template_obsolete PD_Template

PD_FieldBusDevices_obsolete –

PD_ModBus_obsolete –

PD_ModbusTCPIP_obsolete ModbusHandling

PD_MultiBelt_obsolete PD_MultiBelt

PD_Isa_obsolete PackML

PD_Robotic_obsolete Robotic
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Obsolete library Present library

PD_SmartInfeed_obsolete PD_SmartInfeed

PD_Unwinder_obsolete Unwinder

PD_PacDriveLibModules_obsolete AxisModule

PD_IsaForTemplate_obsolete –

PD_EasyTCP_UDP_obsolete TcpUdpCommunication

PD_FieldBusDeviceModules_obsolete –

PD_MultiBeltModule_obsolete PD_MultiBeltModule

PD_RoboticModule_obsolete RoboticModule

PD_SmartInfeedModule_obsolete PD_SmartInfeedModule

PD_UnWinderModule_obsolete UnWinderModule

PreventaSupport XpsuSupport

Sercos3EnergyEfficiencyToolbox –

NOTE: PD_•••_obsolete libraries are not supported by EcoStruxure Machine
Expert.
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D
DUT:

(data unit type) Along with the standard data types the user can define own data
type structures, enumerationen types, and references as data type units in a DUT
editor.

E
EDS:

(electronic data sheet) A file for fieldbus device description that contains, for
example, the properties of a device such as parameters and settings.

F
FDR:

(fast device replacement) A service supported by the device, that facilitate the
replacement of an inoperable equipment.

G
GVL:

(global variable list) Manages global variables within an EcoStruxure Machine
Expert project.

L
legacy projects:

Application projects that were created with SoMachine, SoMachine Motion, or a
previous version of EcoStruxure Machine Expert.

P
POU:

(program organization unit) A variable declaration in source code and a
corresponding instruction set. POUs facilitate the modular re-use of software
programs, functions, and function blocks. Once declared, POUs are available to
one another.

R
RPI:

(requested packet interval) The time period between cyclic data exchanges
requested by the scanner. EtherNet/IP devices publish data at the rate specified
by the RPI assigned to them by the scanner, and they receive message requests
from the scanner with a period equal to RPI.
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